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Chapter 1. Release Notes for version 12.1.3

Contains information about new features, defect fixes, and known issues in Unica Campaign

and Optimize that HCL releases as part of a scheduled software release.

System requirements and compatibility

Unica Campaign is part of the Unica suite of products. Unica Campaign version 12.1.3

requires Unica Platform 12.1.3

Where to find complete system requirement and compatibility information

For a list of Unica product versions compatible with this product and a list of third-party
requirements for this product, see the Recommended Software Environments and Minimum

System Requirements document.

You can also access this document by selecting Help > Product documentation when you

are logged in to Unica.

Prerequisites for using Unica Campaign

Before you begin using Unica Campaign, confirm that your environment meets the following

requirements.

« For an improved user experience, use at least a 21" screen.

« For an improved user experience, set your screen resolution to 1600 x 900. Lower
resolutions can result in some information not being properly displayed. If you use a
lower resolution, maximize the browser window to see more content.

« A mouse is best for navigating in the user interface.

« Do not use the browser controls to navigate. For example, avoid using the Back and
Forward buttons. Instead, use the controls that are in the user interface.

« If pop-up blocker (ad blocker) software is installed on the client machine, Unica
Campaign might not function properly. For best results, disable pop-up blocker

software while running Unica Campaign.
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« Ensure that the technical environment meets the minimum system requirements and
the supported platforms.*

* The correct browser and versions must be used.*

- Clear the browser cache after upgrading or applying any fix pack. This only needs to
be done once, after the application is updated.

« If you use Internet Explorer (IE) with Unica Campaign or any module that uses
Unica Campaign flowcharts (Unica Deliver, Unica Optimize, Unica Interact, Unica
Collaborate): To log in multiple times to view side-by-side information, open IE and log
in to Unica. Then select File > New Session in the IE menu bar. In the new IE browser

window, log in to Unica as the same or a different user.

Important: Do not use any other method to open multiple sessions. For
example, do not open a new tab; do not open another browser session from
the Start menu or desktop icon; and do not use File > New Window in IE.

These methods can corrupt information that is shown in the application.

*For details on the items indicated by an asterisk, see the Unica Recommended Software

Environments and Minimum System Requirements.

Unica Campaign documentation roadmap

Unica Campaign provides documentation and help for users, administrators, and

developers.

Table 1. Get up and running

Task Documentation

Find out about new features, known | Unica Campaign Release Notes

issues, and limitations

Learn about the structure of the Unica | Unica Campaign System Tables and Data Dictio-

Campaign system tables nary

Install or upgrade Unica Campaign One of the following guides:
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Table 1. Get up and running (continued)

Task

Documentation

« Unica Campaign Installation Guide

« Unica Campaign Upgrade Guide

Unica Insights Reports for Unica

Campaign

Unica Insights Installation and Configuration Guide

Implement the IBM Cognos® reports

provided with Unica Campaign

Unica Reports Installation and Configuration Guide

Table 2. Configure and use Unica Campaign

Task

Documentation

« Adjust configuration and securi-
ty settings

* Prepare Unica Campaign for
users

* Run utilities and perform main-
tenance

« Learn about integrations

Unica Campaign Administrator's Guide

« Create and deploy marketing
campaigns

« Analyze campaign results

Unica Campaign User's Guide

Improve flowchart performance

Unica Campaign Tuning Guide

Use Unica Campaign functions

Macros for HCL Unica

Table 3. Integrate Unica Campaign with other HCL products

Task

Documentation

Integrate with Acoustic

Campaign and Acoustic Integration Guide for IBM
Marketing Cloud
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Table 3. Integrate Unica Campaign with other HCL products (continued)

Task

Documentation

Integrate with Coremetrics

Unica Campaign Administrator's Guide: How to

configure the integration

Unica Campaign User's Guide: Targeting IBM Digi-

tal Analytics segments in Campaigns

Integrate with Unica Plan

Unica Plan and Unica Campaign Integration Guide

Integrate with Opportunity Detect

Unica Campaign Administrator's Guide: How to

configure the integration

Opportunity Detect Administrator's Guide and Op-
portunity Detect User's Guide: How to administer

and use the product

Integrate with Unica Deliver

Unica Campaign Installation and Upgrade guides:
How to install and prepare Deliver components in

the local environment.

Unica Deliver Startup and Administrator's Guide:
How to connect to the hosted messaging re-

sources.

Unica Campaign Administrator's Guide: How to

configure offer integration.

Integrate with IBM SPSS Modeler Ad-
vantage Enterprise Marketing Man-

agement Edition

Unica Campaign and IBM SPSS Modeler Advan-
tage Enterprise Marketing Management Edition In-

tegration Guide

Integrate with IBM WeatherFX.

You can integrate IBM WeatherFX with Campaign
so that you can pull weather events into your mar-
keting campaigns. Unica Campaign version 9 and
version 10 users can integrate with WeatherFX by
using the UBX toolkit.
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Table 3. Integrate Unica Campaign with other HCL products (continued)

Task

Documentation

Integrate with Unica Director.

Unica Director Installation Guide: You can inte-
grate Unica Director with Campaign so that you
can get status of all the running/completed/failed
flowcharts, migrate Campaigns from one Unica
Campaign environment to other, download/delete

flowchart logs etc.

Integrate with Journey

Unica Campaign can integrate with Journey so that
a continuous communication with users can be es-

tablished based on the inputs from Campaign.

Refer Campaign Administrators guide > Unica

Campaign and Unica Journeys integration

Integrate with Link

Unica Campaign uses Link capabilities of connec-
tors which include the configuration and provision-

ing to connect to any delivery channel.

Refer Campaign Administrators guide > Unica

Campaign and Unica Link integration

Note: Additional integrations may be available that are not listed in this table.

Table 4. Develop for Unica Campaign

Task

Documentation

Use the REST API

See the Unica Campaign REST API

Use the SOAP API

« See the Unica Campaign SOAP API Specifi-
cation
« JavaDocs in devki t s\ Canpai gnSer -

Vi cesAPI
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Table 4. Develop for Unica Campaign (continued)

Task

Documentation

Develop Java™ plug-ins or com-
mand-line executables to add valida-

tion to Unica Campaign

Table 5. Get help

« See the Unica Campaign Validation PDK
Guide

« Java-docs in devki t s\ val i dati on

Task

Instructions

Open online help

When using the Unica Campaign application:

1. Choose Help > Help for this page to open a
context-sensitive help topic.

2. Click the Show navigation icon in the help
window to display the full help.

You must have web access to view context-sensi-
tive online help. Contact Support for more infor-
mation about accessing and installing Knowledge

Center locally for offline documentation.

Get PDFs

When using the Unica Campaign application:

 Choose Help > Product documentation to
access Unica Campaign PDFs.

 Choose Help > All Unica documentation to
access all product PDFs.

* Click the links for PDFs during the installa-
tion process.
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New features and changes in version 12.1.3

Unica Campaign 12.1.3 includes a number of new features and changes. These are listed

underneath.

For a list of newly supported and discontinued platforms, see the Recommended Software

Environments and Minimum System Requirements guide.

Upgrade Paths

Unica Campaign supports the following upgrade paths:

*121.x—~121.3
*12.1.0x ~12.1.3

Customers on versions earlier than 8.6.x must:

« perform a Fast Upgrade from existing version to version 8.6.0 (for more information,
see HCL Unica 8.6.0 Fast Upgrade Guide).

« perform a Fast Upgrade from version 8.6.0 to version 12.1.0 (for more information,
see HCL Unica 12.1.0 Fast Upgrade Guide).

« perform an in-place upgrade from version 12.1.0 to version 12.1.3.

Customers on versions earlier than 11.1.x.x can:

« perform a Fast Upgrade from existing version to version 12.1.0 (for more information,
see HCL Unica 12.1.0 Fast Upgrade Guide).
- perform an in-place upgrade from version 12.1.0 to version 12.1.3.

Customers on versions 11.1.x.x/12.0.x.x can use one of the following options for upgrade:

* Option 1
o perform an in-place upgrade from existing version to version 12.1.0.
o perform an in-place upgrade from version 12.1.0 to version 12.1.3.

* Option 2
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o perform a Fast Upgrade from existing version to version 12.1.0 (for more
information, see HCL Unica 12.1.0 Fast Upgrade Guide).

o perform an in-place upgrade from version 12.1.0 to verison 12.1.3.

Log4j Security vulnerability fixes

Unicav12.1.3 now uses | og4j v2.17. 1. This version addresses the critical vulnerabilities
identified in | og4j . It includes the security fixes mentioned in the following Unica

Knowledge base article:
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0095491

For more details related to the fixes in | og4j 2. 17. 1, see https://logging.apache.org/
log4j/2.x/security.html.

Campaign's association and adherence to Contact Central Regional
Preference

In V12.1.3 Unica Campaign, now user can associate Contact Central regional preference
with Campaign. This will help Deliver adhere to quiet hours defined by customer in Contact

Central.

Disable 'Replace All' in Mail-List Process box - Log tab

In V12.1.3 Unica Campaign, in Mail list and Call list Process Box default ability to 'Replace
All' can be disabled/enabled based on configuration parameter.

Segment Update Alert

In V12.1.3 Unica Campaign, on Segment summary screen user can get information of
Campaigns and flowcharts currently using this segment. Also, if user try to alter the
flowchart having a 'CreateSeg' Process Box, then they are alerted with a message stating

the impact.

Fetch Response Date time from Deliver Landing Page in Extract PB

In V12.1.3 Unica Campaign, its possible to use response date time in subsequent process

box of extract PB when deliver landing page is used as an input in extract PB.


https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0095491
https://logging.apache.org/log4j/2.x/security.html
https://logging.apache.org/log4j/2.x/security.html
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'For Every value of' option in Optimize Rules

In V12.1.3 Unica Campaign, Min/Max # offers and Max # duplicate rules will have an option
For Every value Of <Attribute> which can be used to reduce overhead of creating multiple

rules or adding multiple conditions while creating rule achieving the same result.

Oracle ODBC support

Unica Campaign offers Oracle ODBC support this would be actively supported in upcoming

releases as well the support would be available from 12.1.0.4.

Fixed defects in Unica Campaign

The following defects were fixed in Unica Campaign 12.1.3.

Issue ID Description

HMA-332193 Interact List Process Box does not save

the assigned Offer when Maillist is used

HMA-336284 Multiple SQL statements separated by se-
mi-comma under pre/post sql in SELECT

process box hangs the flowchart

HMA-330161 Compare with Function MONTHOF failed

HMA-334199 v12.1.2 : SQL Server : Getting error'In-
valid column name 'NOT_CONTACTED_-
RESPONDERS" for Campaign Response
Trend report

HMA-334403 VERSION : acUpgradeTool Errors while
upgrading from 12.1 to 12.1.1 - SQL Serv-
er Specific

HMA-331136 Extract process box gets unconfigured
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HMA-333774

IE: 12.1.2: Selected category data is not
highlighted in Cell variable crosstab re-
port

HMA-326515

Process box configuration and Flowchart

options are Blank

HMA-333951

Sometimes, when unica_acsvr exists, a

core dump is generated

HMA-335372

Snapshot PB having issues in export to
Extract Table

HMA-335371

Export to Extract Table functionality is not
working in Snapshot PB.

HMA-336894

Save button on custom macro only click-

able at bottom

HMA-334572

While remaping tables getting blank val-
ues for Audience fields.It should not show
blank for already mapped tables

HMA-330613

Documentation Help URL was not work-

ing for French and German locales

HMA-330562

Campaign kafka template was missing

for Docker

HMA-334924

PostgreSQL as Campaign system DB
causing issue with integer to Boolean

conversion

HMA-333933

PRE : V12.1.2 :Campaign - Offer assigned
in ML after deletion gets retired but is

shown as blank in ML Treatment tab

HMA-333834

PRE: "Uncaught Type Error" While Access-

ing "Schedules" From Optimize Sessions
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HMA-334657

No Scrollbar Available In "User Roles And

Permissions" Page

HMA-335531

Beta: Interact session flowchart - Snap-

shot PB does not allow to map table.

HMA-334744

REGRR-New Fields in ILPB gets removed

when umapped or selected and clicked <<

HMA-333872

In case of Google BigQuery re-mapping
an existing table, the source table was not

getting auto-populated.

HMA-335058

Duplicate flowcharts observed as Cam-
paign is not only looking at UA_FLOW-
CHART.TEMPFLAG=0

HMA-326459

NULL values in the output list even if Sin-
gle NULL value in the Audience field

HMA-330431

Campaign Offer reports show incorrect
data when SAME offer is used in Cam-

paign as well as Journey

HMA-329442

Clear instruction in case of fast upgrade
to FP

HMA-332412

CS0258292 : Flowchart process crash-
ing when %Z is used with DATE_LFORMAT
macro stored within a Derived field

HMA-324901

Email PB failing with error 21901 when
using & in From Name field in Content

Customization

HMA-334145

Flowchart process endless looping on

SRecordTableAccess:InitUserQuery

HMA-337683

VERSION - Teradata to hive snaphot issue




Unica Campaign V12.1.3 Release Notes | 1 - Release Notes for version 12.1.3 | 12

HMA-334596

[Doc]: Fix Unica Campaign 12.1.0 HTML
Help search issue

Known issues in Unica Campaign

Unica Campaign 12.1.3 includes the following known issues.

Issue ID

Description

HMA-327170

For Docker environment, getting a "Failed
to load data" error on Schedule manage-
ment page if user continuously clicks on
pagination (Next button).

HMA-326854

Incorrect date format written to UA_OF-
FERHISTATTRIB from mail list process

box

HMA-331085

Documentation - Docker : Use -async op-
tion while running ACOOptAdmin utility

HMA-338254

BigQuery database : Cell size limit caus-
ing the Flowchart to hang

HMA-337564

BigQuery : table mapping, default string

size is taken as Maximum

HMA-330433

User is not able to login to platform after
upgrade to 12.1.1 in case Deliver is con-
figured.

Resolution

Execute below query on Platform data-

base:

select * from usm_role_role_map where

role_id = (select ID from usm_role where
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name='Deliver_admin' and applica-

tion=101 and partition_id=<>)

Specify actual partition id in above query,
default for partition1, partition id =1 , it

varies for multiple partitions.

If above result in more than one row, con-
tact HCL support to help in executing be-
low delete query - delete one of the du-
plicate record of *D*eliver_admin role by

running below query :

delete from usm_role_role_map where
role_id = (select ID from usm_role where
name='Deliver_admin' and applica-
tion=101 and partition_id=<>) and paren-

t_role_id=<partition_id>
For example, for partition id =1,

delete from usm_role_role_map where
role_id = (select ID from usm_role where
name="Deliver_admin' and applica-
tion=101 and partition_id=1) and parent_-
role_id=1

HMA-306326 JNDI creation for Campaign installer with
Informix database and Websphere appli-
cation server is not creating JNDI with
correct details. Create JNDI connection
manually in websphere with Informix re-

ferring to the Campaign Installation guide.

HMA-306329 JNDI creation for Campaign installer with
Informix database and Tomcat applica-

tion server is not creating JNDI with cor-
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rect details.Create JNDI connection man-
ually in Tomcat with Informix referring to

the Campaign Installation guide

HMA-332306

Jboss7.3 : Getting "UT005023: Excep-
tion handling request to /unica/servlet/
ScheduleProcessor: java.lang.NoClass-
DefFoundError: oracle/sql/BLOB" error
when user tries to schedule Campaign

flowchart.
Resolution:

Run the below command to make the

module global using jboss-cli.sh/bat

_/subsystem=ee:write-attribut-

e(name=global-modules,value=[
{name=com.oracle.jdbc}

I

OR

1. In <JBOSS_HOME>/standalone/config-
uration/standalone.xml searched module

name for driver.

<driver name="oracledriver" module="ora-

cle.jdbc">

<xa-datasource-class>oracle.jdbc.Oracle-

Driver</xa-datasource-class>
</driver>

2. Then add the below statement under-
neath <subsystem xmins="urn:jboss:do-
main:ee:4.0"> to make the module name

global.
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<global-modules>
<module name="oracle.jdbc"/>
</global-modules>

3. Restart JBOSS server.

HMA-333252 Troubleshooting tip for Campaign Flow-
chart not opening from Schedule manage-

ment page.
Resolution:

Navigate to Affinium|Campaign|naviga-
tion

Change the below parameter
flowchartDetailPageURI=="flowchartDe-

tails.do?campaignID=&id=" to 'flowchart-

Details.go?campaignID=&id="'

HMA-334488 PRE: Java lllegal Argument Exception
While Saving Smart Offer List

HMA-334489 Ul Dropdown Alignment Gets Disturbed If

we use "Spacebar" to open a dropdown

HMA-310343 Campaign flowcharts with old eMessage

process box will not work in v12.1.2.

HMA-312109 Campaign upgrade installation from 12.0

to 12.1.2 completed with 3 nonfatal error.

HMA-300159 HTTP Communication error occurs, while
saving flowchart if Unica Platform and
Campaign applications are using the
same JNDI. It is suggested to use sepa-
rate JNDIs for Platform and Campaign ap-
plications.
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HMA-295574

Deployment of Campaign application in
wWebSphere application server failed
duetoj ava. | ang. NoCl assDef Found-
Error: javax.el.ELManager. Users
are required to copy j avax. el - 3. 0-

. 1b11. j ar in the Websphere application
servers lib directory. They can download
javax. el -3.0.1-bi11.jar from https:/
mvnrepository.com/artifact/org.glass-
fish/javax.el/3.0.1-b11.

HMA-311916

Journey Process box: Searching in Jour-
ney PB retains its last search string. User

need to manually clear the search criteria.

HMA-306110, HMA-306108

While deploying or starting Campaign ap-
plication, it throws errors related to mod-
ule-info.class, and warning related to ob-
solete hibernate namespace. These can

be ignored.

HMA-304803

Getting "jcc][t4][10217][10310][4.14.111]
Connection read-only mode is not en-
forceable after the connection has been
established." warnings in WebSphere con-
sole log. No impact on application side.

These can be ignored.

HMA-306095

Production documentation links on Cam-
paign installer are broken. See the docu-
mentation available along with product in-

stallers.



https://mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11
https://mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11
https://mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11
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HMA-312150 Journey Process box: Search in Associ-
ated Journyes with multiple words is not
working.

HMA-310126 eMessage instances in Campaign unin-

stall folder — these can be ignored. Unica

no longer support eMessage.

HMA-312299 Campaign or Platform navigation url
when contains default http or https port
then recent menu’s does not work. If you
are using default http (80) or https (443)
ports in navigation url please remove

them.

HMA-312231 Campaign swagger APIs will not work on-
ly on swagger page when marketing plat-
form login method is set to Web Access

control.

HMA-303532 With MariaDB as system database Opti-
mize, Maillist or Calllist process box exe-
cution fail with error 10646. You must en-
able In DB Optimization in flowchart ad-

vance settings to resolve this error.

HMA-13460 When the Export to File option is
unchecked on the Fulfillment tab of the
Mail List process, the Summary File op-

tion is enabled but should not be.

HMA-175825 When def aul t Behavi or WhenQut put To-
FileissettoCreate New Fil e, it works
only when you select a new output (ex-
port) file for the first time. If you try to
change the existing output file and select
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a new output file, then the option Append
to Existing Data gets selected by de-
fault. It can be changed manually to Cre-

ate New Fil e.

APAR 198495, PO05293, 198494

For a custom macro, if a user account
has assigned as Not Granted permission
for a stored object (Custom Macros, Flow-
chart Templates, Stored Derived Fields,
etc.), the custom macro can be used to
edit, delete, add, move all stored objects

regardless of permissions.

HMA-204347

LARGE_DATA: Browser Crash - Mail List
process box with 700 segments - Save

with 512 offers to each segment.

HMA-211253

File-based input with multiple columns
containing date in different format does

not read the date correctly.

HMA-212890

Boolean type column on Amazon Redshift

is recognized as 'Test' field type in table

mapping.

HMA-220474

When the column name of the source
table contains Non-ASCII characters

and is long (probably longer than 10 x
3bytes characters in UTF8), the Snapshot
process does not run because the temp

table is not created.

HMA-220705

Profiling count for Dimension table fields
is incorrect and profiling percentage is
displayed as 100% even if profiling is in

progress.
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APAR 222047, P006172, 222049 Unica Campaign extract process does not
write to DB2 database when flowchart is
configured with two extract processes
and the second extract process contains
a derived field that uses French accent-
ed characters in the name of the derived
field.

APAR 225568, PO06304, 225572 t enpt abl epost execut i onsqgl is not run

when selecting coremetrics segment.

HMA-230340 Inconsistent behavior for the Mail list
process is observed when the data filter
is assigned to Effective date on the Pa-
rameters tab in a new Mail list process
when compared to an edited existing Mail
list process. The Mail list process does
not output a datetime derived field in the
output log file. Changing the effective
date parameter values might cause exe-

cution failure of the Mail list.

HMA-230606 In a flowchart where fields are extracted
and used in a Mail list process, the fields
under Extract Node on the Personaliza-
tion tab of the Mail list process are differ-

ent before and after running the process.

HMA-231859 While using the Chrome browser, it takes
around 20 seconds to respond while load-
ing the Personalization tab of the Mail

list process if it contains large number of

treatments and offers assigned. For ex-

ample, a Mail list process with 250 cells,
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each cells with multiple offers, each offer

having multiple attributes.

HMA-232502

A Mail list performance issue occurs
when the user changes the input in any
way and there is a delay when initially
switching tabs. After the user changes
the input and switches to the Treatment
or Process tab for the first time, there is

a delay of around 10-15 seconds depend-
ing on the number of inputs selected. Af-
ter this initial delay, there is no delay until
the input is changed.

HMA-232835

The Campaign application performance
is affected and sometimes an exception
error message is displayed on the Cam-
paign pages when the application is used
for a longer time (some days) with contin-
uous usage. You must restart your Cam-
paign web application and Campaign Lis-

teners.

HMA-238789

While using the Chrome browser, when a
user opens a Mail list with 600 cells hav-
ing multiple offers assigned to each cell,
the application stops responding. While
using the Internet Explorer 11 brows-

er, nothing is displayed in the Mail list
process box.

HMA-239142

When the Audience process fails because
of an incorrect Count filter expression,
and the user removes the filter expres-

sion, adds a Condition, and runs the Au-
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dience process again, the process fails.
The Condition is not considered and in-
stead the previous Count filter expression
is used resulting in the failure. To run the
Audience process successfully, you must
re-open the Audience process configura-
tion window, click the Condition, Save and
Close. The Audience process now consid-

ers the Condition and runs successfully.

HMA-271642 A"Please wait..... " message is dis-
played multiple times in console mode in-
stallation while upgrading from version

10.1 and also for new Installation

HMA-271676 The Extract table on the DB2 and Oracle
databases is not deleted when In-DB opti-

mization is unchecked.

HMA-272253 The Campaign application performance
is affected when a user opens the Table
mapping window and more than 500 ta-

bles are mapped.

HMA-2968 Hot keys are not implemented on most of
the windows. In the Dojo implementation
it is not possible to use keyboard short-

cuts to activate certain functions. Instead

the user must click buttons.

HMA-PMR 266519, 75262 Clicking Return to previous page distorts
the user interface in some cases. Use

the links within the products to navigate,

rather than the browser controls.
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N/A

When Unica Campaign is deployed in

an application server cluster environ-
ment with 80 port, the Campaign nav-
igation URL should not contain this

port number. For example: http://

<host >. <domai n>: 80/ Canpai gn shoul d
be changed to http://<host>. <do-

mai n>/ Canpai gn. Change the value of the
serverURL property under Campaign|nav-

igation on the Settings > Configuration

page.

N/A

Mail List process box gets unconfig-
ured with error "31606: History table are

changed" on Flowchart run.

1. There is no issue if the history ta-
bles are mapped prior to building
a flowchart and adding a Mail List
process.

2. If you do not follow step 1, you can
still map the history tables after the
error appears. If you edit the flow-
chart and configure the process

box, the process will run.

N/A

After migrating non-ASCII data to Cam-
paign, in some cases you cannot open
Campaign flowcharts on the target sys-
tem. Session flowcharts open successful-
ly. To work around this issue, remigrate
the campaigns in overwrite mode. You

can then open the flowcharts.
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TT 062333 Information related to associated prod-
ucts does not appear in offer on Market-
ing Operations. When an offer created in
Campaign with products associated with
it is imported in Marketing Operations, in-
formation about the associated products

is not available in Marketing Operations.

HMA-270655 Table Mapping : Table name containing @
is supported while mapping a table, spe-
cial characters like @ are should not be
supported in Table names. Since Table
name containing @ is supported since
some time, this functioning is not updat-

ed now.

HMA-283637 When user has one maillist PB config-
ured in the flowchart and he adds anoth-
er maillist PB in the same flowchart, it

is observed that All the values from al-
ready configured in treatment tab, Para-
meters tab, Personalisation tab of new
Maillist PB appear automatically in any

new dragged maillist PB.

HMA-281389 While running Campaign in the Upgrade
mode, the installer should read the instal-
lation properties files from the previous
version response files as we had that re-
sponse available at the install location
from the previous installation. However,

it does not read the installation proper-
ties files from the earlier version response

files.
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HMA-280623

In Sample PB if we specify '3"in "# of
Samples/Output Cells" field and Config-
ure [sample1] with 3 samples having sam-
ple sizes as 50%, 50% and "All remain-

ing records" respectively based on "Ran-
dom Sample method" then after running
Flowchart if we reopen the Sample PB
"Process run results will be lost. Contin-
ue?" message is displayed in sample PB

when remaining All check boxed is check.

HMA-283101

CHROME: "Unable to notify roles/per-
mission changes to Campaign, Deliver
OD may be out of sync". On clicking save
changes for the Security Policy displays
the following pop-up, this happens just
first time after user logs in and changes
anything in the policy and clicks save
changes. Also, this is reproducible just
on CHROME. Tested on Chrome V64 and
V65.

HMA-282844

Campaign Offer doesn’t sort on 'Chan-
nel' & 'Eff./Exp.Dates'. After clicking on
every column the offers below it should
be sorted in ascending order. If you click
on the same column the second time, the
offers beneath it should be sorted in the

descending order.

HMA-283695

Segment process box execution failed
with extract enabled to User database for
the IMPALA user DB. This error does not
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reproduce when extracting to Unica Cam-

paign server.

HMA-284436 Platform.war and campaign.war in ear
file deployment will not work in Weblog-
ic 12.2.1, work around is to deploy cam-

paign.war and unica.war separately.

HMA-288228 If the date field uploaded to IMC side

is not in mm/dd/yyyy format, the email
process box fails to execute. This da-
ta format is required by IMC Importlist
API. It works accurately if DELIM_M_D_-
YYYY(mm/dd/yyyy) format is used for
date while uploading to IMC using im-

portlist API.

HMA-289135 TOMCAT : Occasionally Unica Platform
or Campaign does not gets started after
deploying in tomcat application server.
Workaround : delete Campaign and Plat-
form directory available inside Tomcat
webapps directory and delete the content
of work directory from the path where

Tomcat is installed.

HMA-304945 Refresh command does not refresh
the master listener priority or weight, if
you need to make changes in priority or
weight you require to take a downtime

and restart the application.

HMA-312445 Link Process box - sending data only for

the first input cell selected to link.
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UL-285

Connection Salesforce - Subsequent
Salesforce actions are failing for Update
(Lead/Contact) intermittently.

UL-250

Connection Mandrill - Intermittenly stop

sending emails to targeted audiences.

UL-281

Connection Mandrill - Subject line with
non english characters - mandrill not

sending email to user.

UL-259/UL-242

Connection Mailchimp/Mandril - results

would be available for 1000 users only.

UL-214

MailChimp/Mandril - Audience value is
getting changed to id field after selection

or reopening process box.

UL-194

MailChimp/Mandril - In Mandrill template
if merging field added as localized char-

acter - personalization is not working.

UL-257

Link Connections page takes time to load

in the Campaign process box.

UL-231

Twilio Connection - Only 5 fields are sup-
ported for personalization in SMS body/

text area.q

UL-279

Connection MailChimp - Branch run or
single link process box run is not support-
ed with Link process box with Mailchimp
connection. You will need to execute

complete flowchart.

UL-287

Link process box fails when no output da-

ta.
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NA Unica Campaign and Unica Link applica-
tions urls should be having same domain
names. Unica Campaign and Link applica-
tions deployed on different domains will

not work.

UL-189 Connection Mandrill/MailChimp- Emo-
jis are not working in Mandrill and

MailChimp connector Mail Subject line.

HMA-313650 Platform Scheduled flowcharts are not
getting executed afterupgrade.Use the
quartzjobtool to update scheduler jobs.
This is a requiredstep. If this upgrade tool
is not run, any existing scheduled job will-
fail to start. The quartzjobtool is in the
tools\bin directory underUnica Platform
installation. Run this utility from the tools
\bindirectory.Example command (Win-
dows): quartzjobtool.batExample com-

mand (Unix): ./quartzjobtool.sh

HMA-306383 UBX registration utility is failing with er-
ror Caused by: java.lang.ClassNotFound-
Exception: org.jboss.logging.BasicLogger

error

HMA-316802 MariaDB]:CODE 704: File write error. while
extracting extracted fields and table fields

to database server through Segment PB

HMA-338395 v12.1.3: Campaign : Selecting export to
Kafka makes Snapshot PB unconfigured.

Needs workaround to run
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HMA-338387

For version 12.1.3, the copyright year is
incorrect in the Fed Response File Re-

sponseFil es.tar. gz.

Known issues in Optimize

The following are the Known Issues for Optimize in V12.1.3

Issue

Issue ID

Description

Scores entered manually in the score
matrix are not considered while opti-

mizing the contact list.

Defect 194109

Scores entered manually
should be considered for cal-
culation in the Customer Ca-
pacity rule. However, while
applying the Customer Ca-
pacity rule, scores in the PCT
are considered, and all cus-
tomer records are removed

in the optimized list.

Campaign Optimize summary report is

incorrect.

Defect 176368

If offer versions are used in
arule, the report that shows
pre-optimization versus post-
optimization counts will al-
ways report the pre-opti-
mization count of records

as 1. The post-optimization

counts will be correct.

After upgrading Campaign to 9.1, Opti-
mize listener can no longer be stopped
via ACOSer ver . sh.

Defect 81245

Users must upgrade Unica
Campaign and Unica Opti-
mize together. If they can-
not, they will need to stop the

Unica Optimize listener man-
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Issue

Issue ID

Description

ually through the task man-

ager/kill command.

Error messages for the ACOOptAdmin
utility do not display according to non-

English locales.

DEF051284

When you run the ACOOpt-
Admin command line utility
in a locale other than English,
error messages do not dis-
play according to the spec-
ified locale. The error mes-
sages display only in English.

unprocessabl es_sessi oni d. csv
might contain some customers who re-

ceive offers.

DEF054841

In some scenarios, a few of
the customers who get of-
fers might be present in the
unpr ocessabl es_ses-

si oni d. csv file.

Incorrect optimization result with Cus-
tom Capacity rule in specific circum-

stances.

DEF058362

A customer that satisfies the
following criteria might re-
ceive fewer offers than want-
ed:

» The customer has an
even number of pro-
posed transactions.

« Each of these trans-
actions has the same
score.

* This score is a low val-

ue.

Some labels display incorrectly in

Japanese, Chinese, and Korean.

DEF059595

Some translated labels are
displaying incorrectly. For

example, when you edit the
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Issue

Issue ID

Description

score matrix manually, the
vertical label on the right
side of the table displays
upside down. Also, for opti-
mization rules that contain
customers in the segment,
the segment label displays

on two lines.

Capacity rule.

Offer filtering summary report displays
an incorrect count of Proposed Con-

tacts that are removed by each Custom

DEF059805

The Offer Summary Report
displays incorrect counts in
the "Removed By This Rule"
column for Custom Capac-
ity rules if the participating
Flowchart for this Unica Op-
timize session contains mul-
tiple contact dates and mul-
tiple offers that are made to
each customer on different

channels.

Issues with offer version query builder.

DEF060676

There are several minor is-
sues with the offer version

query builder:

« For custom attribut-
es with the Form Ele-
ment Type of Select
Box, the offer version
query builder does not

use the select box. You



Unica Campaign V12.1.3 Release Notes | 1 - Release Notes for version 12.1.3 | 31

Issue

Issue ID

Description

must enter the value
manually.

* When the group level is
removed, the subgroup
conditions are added
to the parent condition,
and vice versa.

« All arithmetic opera-
tors are displayed for a
string variable, but on-
ly equal and not equal
apply.

« Defined length valida-
tions for attributes are
not verified upon input

for conditions.

Offer version rules that contain dates
do not provide expected optimization

results.

DEF061554

If you create an offer version
condition that includes a
date, such as the offer para-
meter "valid end date" equals
"12/31/2011", the rule con-
taining offer version condi-
tion might not be satisfied;
however, the rest of the rules

will work as expected.

Rule exceptions that span calendar

years give incorrect results.

DEF061639

If you create a rule excep-
tion to a Min/Max # Offers
capacity rule that spans
calendar years, such as
07/01/2011 to 06/30/2012,
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Issue

Issue ID

Description

the rule containing rule ex-
ception condition will not be
satisfied; however, the rest
of the rules will work as ex-

pected.

<uni ca_svr adne refresh command

does not reflect the change.

HMA-304945

On a running environment,
after changing the master
listener priority, <uni ca_-

svr adme refresh command

does not reflect the change.

<uni ca_svr adnp refresh command

does not delete the node from cluster.

HMA-305764

If you delete a listener node
from existing cluster, <uni -
ca_svr adnp refresh com-
mand does not delete the
node from cluster. Execution
requests are still observed
going to the deleted node.
Restarting the listener solves
this issue. Will be fixed in up-

coming fixpack.

Users are still able to manually inter-
fere in the running flowchart when
flowchart execution is in progress
through SVRADMIN utility.

HMA-306037

When flowchart execution is
in progress through SVRAD-
MIN utility or using sched-
uler, user is still able to man-
ually interfere in the running
flowchart. Will be fixed in up-

coming fixpack.
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Known limitations in Unica Campaign

Unica Campaign 12.1.3 includes the following known limitations.

Issue ID

Description

HMA-330347

Users can use Sankey flowchart to view
waterfall information. This solution is of-

fered with certain limitations:

For huge flowcharts, with approximately
50+ process boxes, clearly displaying all
process boxes and related flow is difficult.
The information or labels may get over-
lapped and thus look cluttered. Users are
advised to use zoom in and zoom out fea-
ture along with scrollbars to navigate to

area of interest for better picture.

HMA-291963

Browse table in table mapping feature not

to be used

304128

Platform login method or users authenti-
cation from third party directory services
is not supported with Campaign or Opti-

mize APIs. Users require to use the Unica

Platform user to use with APIs.

305130

The flowchart template is not imported, if
it contains data source name more than
256 character length. Save the flowchart
template again by changing the data-
source name with less than 256 chars.

305764

For any reason, if users delete the Cam-
paign listener node configuration from lis-

tener cluster configuration in Unica Plat-
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form, while the application is up and run-
ning then users connected to this listen-
er node are not redirected to another lis-
tener. You must restart the Campaign web
application. If you require to delete the lis-
tener node, take a downtime and restart

Campaign web and listener components.

17202

Error 19024: Cannot delete segment fold-
er if the segment was deleted from the
folder. A segment that is deleted from a
folder remains as an inactive segment in
the folder. Folders with inactive segments
cannot be deleted. This is working as in-
tended.

185854

Big data: Campaign integration with
Hadoop-based Hive big data as a user da-
ta source is not tested on MS Windows

operating system.

190621

Big data: Campaign with Hive big data as
a user database does not support user
table mapping with Base and Dimension
levels up to the fourth level hierarchy. If
you map a Base record table with four
levels of dimension tables in a Select
process box, then build a query based on
the fourth level Dimension table, the query
fails with Error 11528. This issue should
not affect big data users because multiple
dimensions should not be needed. By de-

finition, a big data source has a large ta-
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ble of records split across Hadoop nodes
(such as HDFS).

194095 For Redshift database, the error message
"Unsupported type timestamps with time
zone" is displayed when exporting data
from a Snapshot process box. Timestamp
with timezone is an unsupported Postgre-
SQL data type on Amazon AWS.

195581 While running a Campaign flowchart, if lis-
tener crashes or is stopped, user is not
able to access the running flowchart from
the Ul. Requests are being served by an-
other node of the cluster but while ac-
cessing the flowchart, a pop-up message
says "listener failover occurred..." It may
be necessary to restart the master listen-

er.

232032 User can start only one Campaign listener
on one server (machine) in case of Listen-

er clustering.

PMR 243195, 244148 When a column that has the Greek Letters
A and B is profiled in Campaign, the sys-
tem returns only A along with the count
of all the records. After the fix, some of
the non-English characters, which differ
only in case (like é and E in French), are
counted as two different values in profil-
ing. English language characters are not

counted as case sensitive.
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244482

Deep search lists all the Campaigns that
are created through Marketing Operations
projects when Campaign - Marketing Op-
erations integration is on. Campaigns
that are created through Marketing Op-
erations projects when Marketing Opera-
tions - Campaign integration is enabled)
are not listed on Campaign list page and
are only available on the Marketing Oper-
ations project listing page. Users who do
not have the permission to access Mar-
keting Operations are able to access cam-
paigns which are created through Mar-
keting Operations projects through Deep
search results.

248943

If the user profile database is changed
(change in the table column values of au-
dience record) for fields other than sync
fields and the user runs the Email process
again, a negative count is returned for the
DUPLICATES parameter from Engage in
the Campaign flowchart log.

N/A

Big data: To perform the UPDATE opera-
tion on any process boxes in a flowchart,
ensure that your HIVE tables are config-
ured as transactional tables such that
they support the ACID property. This is

a key feature introduced in HIVE version
0.14.

N/A

Interact when configured with IBM Web-
Sphere Application Server: You must con-
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figure IBM WebSphere JVM to use JDK
1.7. When IBM WebSphere Application
Server 8.5.5.x is configured with JDK 1.7
and HTTPS communication, you must use
IBM JAVA SDK version 7.0.8.10 or higher.

N/A Using multiple SQL statements for raw
SQL queries is not currently supported
on big data user datasources. For related
information, search the IBM Knowledge
Center for Hive query language confor-

mance.

N/A Dialog behavior: In certain cases, it is nec-
essary to click twice in order to activate a

field or change a field value.

N/A The noni t or Enabl edFor Del i ver configu-
ration property in Canpai gn| noni t ori ng

is not currently used.

N/A Relevant products limitation: When offer
management is performed from Unica
Plan, the "relevant products" functionality,
which relates product IDs to offers, is not

available.

N/A Blank or incorrect results from derived
fields in a Mail List process. This can oc-
cur in a process box that uses a derived
field that calls a Generated field (UCGF)

that changes value.

Do not use a UCGF in a Mail List derived
field if the UCGF is not constant. Also,

from the Parameters tab, do not create a
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derived field to call a UCGF to populate of-
fer attributes.

N/A

Profiling a Campaign Generated Field
(UCGF) does not yield correct results.
Some UCGFs have a value according to
the cell or the offer being processed. For
cell-related UCGFs, only the value associ-
ated with the first cell appears during pro-

filing.

N/A

The default value for a custom cell at-
tribute does not appear when you open
the target cell spreadsheet. Although the
default value is not initially displayed, it
will be used. The value can be displayed
or changed by clicking or opening and
editing the custom cell attribute in the tar-

get cell spreadsheet.

N/A

The UA _Usr ResponseType. Nare field can-
not contain a left parenthesis followed by

a single quote.

N/A

Use unique TenpTabl ePr ef i x for each da-
ta source when mapping multiple data

sources to same physical database.

If you mapped multiple data sources in
Unica Campaign to the same physical
database, and you use the same TenpT-
abl ePr ef i x for more than one of the da-
ta sources, when you use the cleanup util-
ity to delete orphaned temp tables, it may
falsely identify temp tables as orphaned,

when they are in fact legitimate temp ta-
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bles defined from a different Unica Cam-

paign data source.

Any deleted temp tables will automati-
cally be recreated when you rerun affect-
ed flowcharts, but as a best practice, use
a unique TenpTabl ePr ef i x for each da-
ta source when mapping multiple data

sources to the same physical database.

If the data sources defined in Unica Cam-
paign map to different schemas in the
database, another solution is to ensure
that the database user who runs the
cleanup utility does not have privileges to
drop tables in other schemas in the same

database.

161323 The error "Login failed. Error 10553" can
occur if you try to log in to the Campaign
utilities when the Unica Platform | Secu-
rity | login method is set to Windows in-
tegrated login or Web access control. To
avoid this issue, change the login type to
LDAP or Platform prior to using the Cam-

paign utilities..

176377 DB2 10.5 BLU for user DB: No indexing re-
quirement for temp tables in Unica Cam-
paign datasource. DB2 10.5 (with BLU fea-
ture ON) does not require indexing in Uni-
ca Campaign. Unica Campaign has cer-
tain properties for datasources, such as
TempTablePreTruncateRunScript, Temp-
TablePostExecutionSQL, and PostTempT-




Unica Campaign V12.1.3 Release Notes | 1 - Release Notes for version 12.1.3 | 40

ableCreateRunScript, where you can pro-
vide SQL or scripts to create indexes on
user database tables. If you are using DB2
10.5 as a customer database, with the
BLU feature ON, you do not need to con-

figure any of these temp table properties.

201,968,200,241

If two process boxes are moved very
close together in a flowchart, the direction
of the connection arrow changes. This
limitation affects the visual representation
of the arrow. The process data flow is not
affected. The workaround is to move the
process boxes farther apart so the arrow-
head changes back to the correct direc-

tion.

211293

In Unica Campaign, the built-in macro
Current_Date() results in an error when ex-
ecuted against a Hive 1.2 based Big Data
instance. The Hive ODBC driver does not
support the Current_Date macro to obtain
interval values. For example, executing

the following query results in a Hive error:

SELECT DISTINCT customerid FROM Cus-
tomer_date WHERE ((Customer_date.my_-
date_mmdyyyy - CURRENT_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported

conversion from type: interval_day_time

Workaround: To use the Current_Date
function in a RAW SQL query on Hive with
Hortonworks, execute SQL in the follow-

ing format:
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SELECT DISTINCT customerid FROM Cus-
tomer_date WHERE (current_date() - my_-
date_mmddyyyy ) = interval '0 0:0:0' day to
second

310769 In Unica Campaign, the built-in macro
Current _Dat e() results in an error when
executed against Impala data source. The
Impala ODBC driver does not support the
Current_Date macro to obtain interval val-
ues. For example, executing the following

query results in an error:

INSERT INTO TABLE UAC_133824_5
SELECT DISTINCT store_id, d_customer_-
key FROM srvacammo.bast_segment
WHERE (srvacammo.bast_segment.ba_-
last_trans_date > (CURRENT_DATE - 2))

Error: Error while executing a query in Im-
pala: [HY000] : AnalysisException: Could
not resolve column/field reference: ‘cur-

rent_date'

Workaround: In raw SQL query, the Cur -
rent _Dat e would not work with Impala, so
instead of current _dat e, users can use

now() Oorcurrent tinmestanp().

213088 If Campaign is installed in a secured en-
vironment but IBM Cognos is in an unse-
cured environment, Cognos reports will
not display when you use Microsoft In-
ternet Explorer 11. Workaround: If Unica
Campaign is configured with HTTPS, also

configure IBM Cognos on HTTPS.
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217488

IBM can support the Database Loader for
Redshift until the moment Campaign trig-
gers the Loader Script. Any problems in
execution of the loader script are not sup-
ported by IBM.

223716

Authentication Bypass Using HTTP Verb
Tampering

Instead of applying theHttpVerbFil-
ter.class patch, you can use the following

workaround to ensure application securi-
ty.
Complete the following steps to update

web.xml.

1. Update the web app tag and set the

xsd version to 3.0.

<web- app
xm ns: xsi ="http://ww.w3. or

g/ 2001/ XM_.Schema- i nst ance"

xm ns="http://java. sun. com

/xm / ns/javaee"

xsi : schemalLocati on="http:/

/java. sun. conf xm / ns/ j avaee

http://java. sun.com xm / ns
[ j avaee/ web- app_3_0. xsd"
i d="Pl at f or nt
ver si on="3. 0"

met adat a- conpl et e="true" >
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2. Add the following in web.xml.

<I--[start] WhiteList Http
Verbs -->
<security-constraint>

<web-r esour ce-col | ecti on>
<web- r esour ce- name>Uni ca_Wh
iteList Htp_ Verbs</web-reso

ur ce- nane>

<url-pattern>/*</url-patter

n>

<ht t p- met hod- omi ssi on>CET<

/ ht t p- met hod- oni ssi on>

<ht t p- met hod- om ssi on>PCOST<

/ ht t p- met hod- oni ssi on>

<ht t p- met hod- omi ssi on>TRACE

</ ht t p- net hod- oni ssi on>

<ht t p- met hod- om ssi on>PUT<

/ ht t p- met hod- oni ssi on>

<ht t p- met hod- omi ssi on>DELET

E</ ht t p- net hod- oni ssi on>

<ht t p- met hod- omi ssi on>PATCH

</ ht t p- net hod- oni ssi on>
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<ht t p- met hod- omi ssi on>CPTI O

NS</ ht t p- net hod- om ssi on>

<ht t p- met hod- om ssi on>HEAD<
/ ht t p- met hod- oni ssi on>
</ web-resource-col | ecti on>
<aut h-constrai nt/>
</ security-constraint>
<I--Tend] WiiteList Htp

Ver bs -->

283805

IBM Websphere Application Server 8.5.5
Fix Pack 12 requires IFP185892 to run HCL

Unica application.

283544

On Oracle 12.2 database server following
parameters needs to be added in sqlnet.o-
ra file located under ORACLE_HOME/net-
work/admin/SQLNET.ALLOWED_LO-
GON_VERSION_SERVER

User will need to consult with DBA to pro-
vide appropriate value to this parameter.
Please refer this link for details: https://
docs.oracle.com/database/121/NETRF/
sqlnet.htm#NETRF2016

N/A

Campaign Integration with Watson Mar-
keting Assistant is not supported on Inter-

net Explorer.

286705

Two events get generated on the Cam-

paign history tab when user pauses the


https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016

Unica Campaign V12.1.3 Release Notes | 1 - Release Notes for version 12.1.3 | 45

Campaign flowchart from Operational

monitoring.

287100 History tab data remains in UA_History ta-

ble even after deleting the Campaign

290172 Cutting off right contents from Relevant

offers window.

Workaround: The size of text, apps and
other items - under Display should be set
to 100%.

312318 Campaign flowchart run - when executed
as complete flowchart generates a unique
runlD and its executed the flowchart along

with mailchimp process box.

Next time when Campaign user tries to
run the single process box - it does not
generate unique runlD and thus process

box execution failed.

312296 HTTPS(Invalid certificate) HIP instance
is not supported in IE11 for Link PB and

Manage Link Connections page.

312320 MailChimp - Audience value is getting
changed to other format f239295fe8

(in alphanumeric format) if we re-

open correctly configured Link PB. The
workaround is to hit the Fetch button adja-
cent to the field which will refresh the val-

ue of the user-friendly string value.

312567 Campaign installer failed to update In-

sights report files when installed using
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non-root user on Unix environment. To
overcome this user would need to update
Insights report file manually after installa-

tion is completed.

1. Navigate to <PLATFORM_HOME>/In-
sights/tools/bin/

2. For UNIX:

« Grant read, write, and execute per-
missions to - bPat h=<Report fol d-
er pat h> for the installation user.

- Grant execute permission to the in-
stallation user using the following

command.

chnod 755 insightsDBUil.sh

3. Execute command to update the Cam-

paign Insights report files.

./insightsDBUtil.sh -ds=Campaign-

DS -bPath=<Report folder path> -DB-
Type=<databasetype> -URL=JDBC con-
nection URL> -user=<database user>

-pwd=<database password>

For more details refer Unicalnsights12_-

TInstallationConfigurationGuide

313216

Link: Unica application on HTTPS and uni-
ca Link on HTTP does not render the Man-
age links connections page.
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Known limitations in Unica Optimize

Unica Optimize includes 12.1.3 includes the following known limitations.

Issue Number Description

Strings in the production or | Defect In the case of a non-English setup, the

test pop-up window are not | 176920 strings in the production or test pop-up win-

translated. dow are not translated.

The MailList process fails Defect Change the value of UseTempTablePool

with the following database | 170951 from TRUE to FALSE in UA_SYSTEM_TABLES.

error: ORA- 00999: | NVALI D The MailList run will end successfully.

VI EW NAME.

Unica Optimize does not Defect In case of a schedule run of a Unica Opti-

terminate the uni ca_acsvr 164875 mize session by using the Unica Platform

process that is opened dur- Scheduler, you observe multiple uni ca_-

ing a run. acsvr login processes. These processes
might terminate automatically after some
time.

A DB2 database user change | Defect To avoid having a session fail, the DB2 data-

of system tables causes a 155876 base administrator should remove indexes.

Unica Optimize session to

fail when the administrator

has an index with the same

name.

In a Unica Optimize report, Defect The following issues were noticed while

offers by type and segment | 102889 printing the offers by type and segment in a

do not get printed as de- Unica Optimize report.

sired.
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Issue

Number

Description

1. The preview window does not scroll,
unless it is resized.

2. While printing it does not print every-
thing, but only what fits in A4 size.
Printing options do not seem to make

any difference.

Negative scores cause inac-

curate rules crediting.

DEF041400

If you use negative scores, rule crediting in
the Offer Filtering Summary report might not

be accurate.

Offers with negative scores are given to

meet minimum requirements only.

Cells that are linked to TCS
with offer assignments
do not appear in Optimize

process.

DEF061355

If the Optimize process is connected to one
or more cells and the upstream cells are lat-
er linked to top-down cells defined in the
Target Cell Spreadsheet process (TCS),

the offers that are assigned in the TCS do
not automatically appear in the Optimize
process. Link to any top-down cells in the
TCS before you connect those cells to an
Optimize process. Otherwise, you must ei-
ther manually assign the same offers within
the Optimize process, or delete the Optimize

process and re-create it.

Running the ACOOptAdmin
utility with one-way SSL re-

quires more setup.

DEF046832

You cannot use the ACOOptAdmin utility
with one-way SSL until you register a se-
curity certificate, specify a host name and
domain, and configure SSL_Options in the
ACOOpt Admi n. bat file.
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Issue

Number

Description

Unable to run the session in
first attempt when unica_a-

cosvr process stopped.

DEF055010

If you use the kill command to stop uni ca_-
acosvr, the next time you attempt to run a
Unica Optimize session, it might fail with the
following error: An unknown conmmuni cati on
failure has occurred with the Opti-

nze server process.

Workaround - Run the Unica Optimize ses-

sion again to complete it successfully.
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